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IST Y PPS Release 25.2.0
WHAT IS «LIST MY APPS» ?

This app lists all macOS® applications purchased from the Apple App Store that are installed on your
Mac. As an option, all applications from the “/Applications” folder (from macOS 10.15 also /System/
Applications) can also be listed. It is also possible to search all available drives for applications.

Features:

e Finds all applications in the “/Applications” directory (from macOS 10.15 also /System/Applications)
e Finds all applications purchased from the Apple App Store
e Finds all iOS applications in the “/Applications” directory (only available for Apple® M# CPU)
* Detects all applications located on all available drives
* Number of applications is displayed in the Dock
e Support for macOS 10.14 Dark Mode
e Support for the task bar
e Details about the selected entry
e Application icon
* Application name
* Version
* Date of last modification
* Time of last modification
e Copyright
* Application category
* Application path
* Application bundle information
* Application bundle name
® Minimum OS
® Retina support
e Application from the App Store
* |s an iOS application (only available for Apple® M# CPU)
* Manufacturer URL
e Finder tags for the application
* Size
e Context menu with the following features
e Starte App
e Zeige App im Finder
o Offne Hersteller URL
e Each application can be started with a double click
e List of all applications with all details
* Export all data as CSV and XLSX file
® The details of an application can be saved in the following formats:
e Adobe® PDF
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® Open Office® ODT
e Word® DOCX
e Excel® XLSX

START APPLICATION

Release 25.2.0

After starting “List My Apps,” all apps from the “/Applications” directory that are installed on your

computer are listed.

The following apps can be listed in the main window:

e All apps

* No App Store apps
* App Store apps

¢ iOS apps*

[ 2N
=
2 0 06 © 72
All Apps No AppStore AppStore Only i0S All Drives

Name

@ Acana ABCopy

Acana Acronyms

Acana App Language

617

N“N"“" Acana Barcode

rrs o]

ﬂ? Acana Billing Manager
Acana Blutdruck Protokoll
Acana Currency Converter
Acana Folder List

Acana Fuel Prices

Ag

i\:": Acana KeyCode

Acana License Manager
Acana Map2Pin

Acana My Books

« 7 Acana My Coins

Acana My Jewellery

Acana My Whiskey

SONOCOSNHEBG®M®

Acana Network Scanner

Acana Network Services

List My Apps
= ® 0 <
Show List Reload Sharing

13 @

555 A

438 D

17

The number of “iOS apps”, “"All apps”, “No AppStore” and "AppStore only” is displayed at the bottom
right. The number of applications currently displayed is shown in the dock.

6 3 387 A 294 3 93 D

* (only available for Apple® M-CPU)
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IST Y PPS Release 25.2.0
HOW IT WORKS

All applications from the “/Applications” folder are listed in the main window of “List My Apps”. The
applications are sorted alphabetically and displayed with the corresponding application icon. Each
application can be started directly by double-clicking on it.

[ ) [ ] List My Apps
O 06 061 =0 nh -«
All Apps No AppStore  AppStore Only ioS All Drives Show List Reload Sharing
Name
Acana Billing Manager
Acana ABCopy .

Acana Acronyms aa 1
€4

Save as...
Acana App Language
Tp—
o rsueocd
} Acana Billing Manager Version: 25.0.0

.‘) Acana Blutdruck Protokoll Date of purchase: 8/1/13, 9:00 AM

@ Acana Currency Converter E==tlpdale B/1b/25A1 2SR
Copyright: ©2025 Horst Jehle

g Acana Folder List
Category: Finance

Acana Fuel Prices L L .
Application folder: 2 /Applications/Acana Billing Manage

Agana
Acana KeyCode Bundle Information:

b Acana License Manager Bundle Name: Acana Billing Manager
@ A Kia2Pi Minimum OS: 10.14
cana Map2Pin
= Retina Display Support:
Ig!]] Acana My Books o
Application from AppStore:
O Acana My Coins Is iOS Application:
—
Acana My Jewellery URL: 3 https://www.pps4me.de
0 Acana My Whiskey Finder TAG:
Size: 192.44 MB
@ Acana Network Scanner

e Acana Network Services

13 @ 555 A 438 17 @
The details or context menu offer you the following additional options:

e Start app
® Show app in Finder

® Open manufacturer URL

Name

Acana Billing Manager
@ Acana App Language .

wm"“““ Acana Barcode ﬂa
Bl

Acana Billin
\ “B Start «Acana Billing Manager»

Acana Blutdru “® Show app in finder Details
“% Open URL «https://www.pps4me.de»
Acana Currency converter Version:
Acana Folder List Date of purchase:

Acana Fuel Prices Last update:

ZEeN:
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Furthermore, all applications can be listed with all details in the list view.

The following features are available in the list view:

e All apps

* No App Store apps

* App Store apps

* iOS apps*

® Export as Excel XLSX file
e Export as CSV file

e Copy all

e Copy selected

e Select all

e Deselect

APPLICATION DESCRIPTION

In the main window of “List My Apps,” you can choose between three different views.

e All apps => All applications from the /Applications folder are displayed

® No App Store => Only applications that are not from the App Store are displayed
e App Store only => Only applications from the App Store are displayed

* iOS => Only iOS applications are displayed*

@ @ List My Apps
o~ o
2 & O 0 = H <
All Apps No AppStore AppStore Only i0S All Drives Show List Reload Sharing

As soon as the display is changed, the number of applications displayed also changes. The
corresponding number of applications currently displayed is shown with a red circle to the right above
the application icon in the dock..

6@ 3311 A 2905 351 @)

Number of all applications
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Number of non-AppStore applications

Optionally, all drives can also be searched for applications. This search can be started via the "All drives”
icon.

”

If this feature is enabled, the “All drives” icon is marked as active.

2

A message will appear beforehand indicating that this search may take a long time.

If this search has already been started, the last runtime in minutes, seconds, and thousandths of a
second is also displayed.

A A

Long Running Time Long Running Time

This function can take a very long time
under certain circumstances!
The last loading time was 00:48.158

OK and don't show this hint again OK and don't show this hint again

This function can take a very long time
under certain circumstances!

Cancel Cancel

The number of applications found is updated at the bottom right of the main window.

* (only available for Apple® M- CPU)
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IST Y PPS Release 25.2.0
SEARCH/FILTER APPLICATIONS

In the main window and list view of “List My Apps,” you can search for applications or filter the display.
The following search functions/filters are available:.

* App name begins with

* App name contains

* App version begins with

* App version contains

e Copyright begins with

e Copyright contains

e Bundle information begins with

¢ Bundle Information enthalt

t My Apps
® o &
Reload Sharing v App name begins with

App name contains

App version begins with

App version contains
Copyright begins with
Copyright contains

Bundle information begins with

Bundle information contains
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IST Y PPS Release 25.2.0
SHOW APPLICATION DETAILS

In the main window, you can call up details about an application by selecting it.
Details about the selected application:

| XN ) List My Apps

2 0 6 060 =® -

All Apps No AppStore AppStore Only i0Ss All Drives Show List Reload Sharing

Name

|||‘||m”“ Acana Barcode Acana BI"II‘lg Manager

J
~\ Acana Billing Manager a
o

Save as... g v

Acana Blutdruck Protokoll

Acana Currency Converter Details

Q Acana Folder List Version: 25.0.0

Acana Fuel Prices Date of purchase: 8/1/13, 9:00 AM
A : :
x.%':":‘:. Acana KeyCode Last update: 8/16/25, 12:31PM
Copyright: ©2025 Horst Jehle
e Acana License Manager
Category: Finance
@ Acana Map2Pin L L .
Application folder: /Applications/Acana Billing Manage
L@:!J Acana My Books Bundle Information:
O‘ Acana My Coins Bundle Name: Acana Billing Manager
- Minimum OS: 10.14
Acana My Jewellery
Retina Display Support:
Acana My Whiskey
Application from AppStore:

Acana Network Scanner Is i0S Application:

€220

Acana Network Services URL: https://www.pps4me.de
Y®| Acana Ofuscation Finder TAG:
Size: 192.44 MB

Acana Password Generator

- Acana QR Code Generator

13@ 555 A&k 438 0 17 &
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COPY, SHARE OR SAVE APPLICATION DETAILS

Release 25.2.0

In the main window, you can share, copy, or open the details of an application in TextEdit. To do so,

select one of the following icons:

U=

Share

Plain Text

A:[ Acana Billing Manager

Version: 25.0.0...

AirDrop
Mail

Messages

00>

Notes
Freeform
Simulator
Reminders
Shortcuts
OneNote
Viber

Telegram

oEa@ " B«

&> Edit Extensions...

Open in TextEdit

@ @ List My Apps-Acana Billing Manager-2025-08-19-074133.txt

Acana Billing Manager

Version: 25.0.0

Date of purchase: 8/1/13, 9:00 AM
Last update: 8/16/25, 12:31 PM
Copyright: ©2025 Horst Jehle

A1l rights reserved

Category: Finance

Application folder: /Applications/Acana Billing Manager.app
Bundle Information:

Bundle Name: Acana Billing Manager
Minimum 0S: 10.14

Retina Support: Yes

Application from AppStore: Yes

Is i0S Application: No

URL: https://www.ppsdme.de

Finder TAG:

Size 192.44 MB

Copy

Details were copied to the clipboard
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The details can be saved in the following formats:

e Adobe® PDF

® Open Office® ODT
e Word® DOCX

e Excel® XLSX

Acana Billing Manager

3

Details

4

nn
[

oDT

=l
] i

o
[
un
11

® Save details as PDF file
% gsave details as ODT file
Save details as DOCX file

Save details as XLSX file

Release 25.2.0

DISPLAY LIST WITH DETAILS OF ALL APPLICATIONS

The main window allows you to view a list of all applications and their details. To do this, click on the

following icon:

2 & O ©

AppStore Only

All Apps No AppStore

Application

@ Acana ABCopy
% Acana Acronyms

@ Acana App Language

M Acana Barcode

ﬁ% Acana Billing Manager
. Acana Blutdruck Protokoll
@ Acana Currency Converter
@ Acana Folder List

Acana Fuel Prices

"% Acana KeyCode

KeyCode

Acana License Manager
@ Acana Map2Pin

Acana My Books

C} Acana My Coins

i0s
Version
2.2.0
1.0.3
21.0
251.0
25.0.0
1.3.0
4:5:
4.0.0
1.0.0
2.0.0
25.0.0
2.3.0
5.4.2

2540

List of applications with all details

ds =
Export Copyall Copy selected
Purchase Date Last Update

8/113, 9:00 AM
8/1/13, 9:00 AM

8/113, 9:00 AM
8/1/13, 9:00 AM
8/1/13, 9:00 AM
8/1/13, 9:00 AM
8/1/13, 9:00 AM

8/1/13, 9:00 AM
8/1/13, 9:00 AM
8/1/13, 9:00 AM
8/1/13, 9:00 AM
8/1/13, 9:00 AM

© 2013-2025 CIMSoft, @pps4Me

10/1/24, 3:13PM
11/29/24, 10:45 AM
11/11/24, 2:05PM
8/16/25, 2:39 PM
8/16/25, 12:31PM
12/3/24, 6:47 AM
9/9/22, 4:47 PM
5/28/25, 6:26 PM
1/27/23, 2:45PM
5/29/25, 9:46 AM
8/14/25, 7:50 PM
5/29/25, 6:54 PM
2/21/25, 11:57 AM
7/26/25, 5:43PM

Table of contents

Select all

Qv
Unselect all

Copyright Category

2012-2023 CIMSoft, @pps4Me Productivity .

©2024 Horst Jehle Reference

2019-2024 CIMSoft, @pps4Me

© 2016-2025 CIMSoft, @pps... Graphics & Design
©2025 Horst Jehle Finance
©2024 Horst Jehle Healthcare-fitness
© 2014-2022 CIMSoft, @pps... Finance
2013-2025 CIMSoft, ppsd4Me  Utilities
CIMSoft, @pps4Me

© 2013-2025 CIMSoft, pps4Me Developer Tools
2015-2025 CIMSoft, pps4Me.de Productivity

® 2014-2025 CIMSoft, @pps... Travel

© 2015-2025 CIMSoft, @pps... Reference

© 2014-2025 CIMSoft, @pps... Finance

13 @ 555 A 438 17 €
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Release 25.2.0

Press the space bar to display details about a selected entry. This feature is not available if multiple

entries are selected.

Acana My Jewellery

Press ESC or Space bar to close details

Details
Version: 25.0.1
Date of purchase: 8/1/13, 9:00 AM
Last update: 7/30/25, 7:28 AM
Copyright: ©2025 Horst Jehle
Category: Lifestyle
Application folder: /Applications/Acana My Jewell

Bundle Information:

Bundle Name: Acana My Jewellery
Minimum OS: 10.14

Retina Support: (V]

Application from AppStore: V]

Is iOS Application:

URL: https://www.pps4me.de
Finder TAG:
Size 284.90 MB

Toolbar menu and its features

Show all applications

Show only iOS applications*

Export menu

iF-OSS®

1§ <
1
Il v
1l ><

I
1]
n

I

Export details of all listed applications as CSV file

Select all

Deselect all

Show all applications

© 2013-2025 CIMSoft, @ppsdMe Table of contents

Show only applications that are not from the AppStore

Show only applications that are from the AppStore

Export details of all listed applications as XLSX file

Export details of selected applications as XLSX file

Export details of all selected applications as CSV file
Copy details of all listed applications to clipboard

Copy details of all selected applications to clipboard
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The following features are available via the context menu:

e Start app
® Show app in Finder
* Open manufacturer URL (if available for this app)

Application Version Purchase Date Last Update Copyright Category
Acana My Books 5.4:2 8/1/13, 9:00 AM 2/21/25, 11:57 AM ® 2015-2025 CIMSoft, @pps... Reference
O Acana My Coins 25.4.0 8/1/13, 9:00 AM 7/26/25, 5:43PM © 2014-2025 CIMSoft, @pps... Finance
o Acana My Whiskeg: E Show app in finder 6/2/25, 3:40PM 2019-2025 CIMSoft, @pps4Me Lifestyle
@ Acana Network sc B Open URL «https://www.ppsdme.de» 16/27/25, 10:48PM  2018-2025 CIMSoft, ppsdMe  Productivity
o Acana Network Services 12/28/22, 7:03 AM
Acana Ofuscation 7/16/25, 1:27 PM CIMSoft, @pps4Me
Acana Password Generator 1.8.0 8/113, 9:00 AM 6/14/23, 2:42PM 2013-2023 CIMSoft, pps4Me  Productivity
g;?ﬁ Acana QR Code Generator 8.5.0 8/1/13, 9:00 AM 5/22[25, 11:59PM  © 2014-2025 CIMSoft - @pps... Productivity

Double-click on an entry to start the selected application.

Application Version Purchase Date Last Update Copyright Category
Acana My Books 5.4.2 8/1/13, 9:00 AM 2/21/25, 11:57 AM ® 2015-2025 CIMSoft, @pps... Referen
Q Acana My Coins 25.4.0 8/113, 9:00 AM 7/26/25, 5:43PM ® 2014-2025 CIMSoft, @pps... Finance

Acana My Jewellery A m 8/113, 9:00 AM 7/30/25, 7:28 AM | ©2025 Horst Jehle

0 Acana My Whis Double click to open application 11113 9:00 AM 6/2/25, 3:40PM 2019-2025 CIMSoft, @pps4Me  Lifestylr

Press space bar to show details

g Acana Network Context menu for more options 11113 9:00 AM 6/27/25, 10:48PM  2018-2025 CIMSoft, pps4Me  Product

o Acana Network Services 12/28/22, 7:03 AM

* (only available for Apple® M-CPU)

EXPORT AS CSV FILE

The details can be exported as a CSV file via the list of all applications.

Toolbar Menu

NN ] List of applications with all details

© 0 © &HLE E E E

All Apps No AppStore AppStore Only iOs
% Export CSV > ~=-= Save all entries as CSV file

Export XLSX > El Save selected entries as CSV file

© 2013-2025 CIMSoft, @pps4Me Table of contents Page 13 of 17
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The CSV export feature is also available via the “File” menu.

E save all entries as CSV file

= Save selected entries as CSV file
o= Save all entries as XLSX file
== Save selected entries as XLSX file

EXPORT AS XLSX FILE

The details can be exported as an Excel® XLSX file from the list of all applications.

Toolbar Menu

[ XN ) List of applications with all details
All Apps No AppStore AppStore Only iOs 1 Selectall Unselect all

EEE Export CSV >
% Export XLSX > === Save all entries as XLSX file

XLSX XLSX

=== save selected entries as XLSX file

The XLSX export feature is also available via the “File” menu.

e Save all entries as CSV file
=, Save selected entries as CSV file

=l Save all entries as XLSX file

= Save selected entries as XLSX file

HELP MENU
The following features are available in the “"Help” menu:

Search

A Open manual 30 72
& New in this release

A Open @pps4Me homepage
A Privacy Policy

A Product information

A; @pps4Me News

Rate on AppStore

More apps from AppStore

Question about the application
Feature Request
<] Report Problem
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MORE APPS FROM @PPS4ME

Click here for more apps from @pps4Me.

CONTACT TO US

If you still have unanswered questions, please send us an email at Contact@Support. Or visit our
homepage.
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COPYRIGHT & GENERAL TERMS AND CONDITIONS

General Terms and conditions for the use of this help book.
I. Right-holders, copying, Copyright

1. The copyright of this help book is by CIMSoft, pps4Me, Horst Jehle, BahnhofstraBe 21, 71063
Sindelfingen, Germany (hereinafter referred to as "author"). The Copyright refers to the graphics, the
text as well as the electronic source text to graphics and all texts as a whole.

2. In the source text of the template (template) is the copyright of the author. This Copyright notice © in
the source text of the manual must not be removed. Already the removal of copyright constitutes
copyright infringement and may be punishable by law.

Add your own copyright notice is not permitted.

3. The provision of this manual with download option on their own or third party websites, the
reproduction and copying to CD's/DVD's or other data carriers for the purpose of disclosure to third
parties both paid and free of charge (except for personal use) as well as a direct link to the download
files is prohibited.

4. With the download of this manual, the user acknowledges the terms and conditions of use.
Il. Free private use
1. This help book is free to personal, private, non-commercial purposes.

2. With the download of this manual, the user receives the right to use the manual for the purposes of
this Terms of use. The property rights in the content fully remain with the author.

lll. Commercial pay use

1. Commercial and thus pay use for the purposes of this Terms of use is when to book a private or third
acquisition business regardless of the size advertised in any way, pay services under a single URL
provided.

IV. Scope of the commercial use

1. The use of this help book is only permitted for a company. The right of use expires with the use at
another company or a subsidiary or parent company. The right of use is each registered Company to
acquire new or pending business.

2. With every purchase of the manual is the internet address (URL) under the manual goes online

3. For any use in accordance with Section IV of the terms of use is a one-time fee for usage numbers.
The amount of the remuneration of utilisation can be requested via E-Mail.

4. Upon payment of the one-time usage fee, the user merely acquires the right of use within the
meaning of these Terms of Use. Ownership of the manual remains with the author without restriction.

5. With one-time payment of the remuneration of utilisation of the user acquires only the right of use for
the purposes of this Terms of use. The ownership of the manual fully remains with the author.

6. Any commercial user will receive a VAT invoice.
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V. Copyright Infringement

1. Any copyright infringement will be prosecuted. The author, a lawyer will always help. Be asserted in
the context of provisional legal protection - if necessary - injunctive-, information- and claims for
damages.

2. A copyright infringement is if the manual with criminal content by the users or by third parties. The
author is displayed next to the assertion of civil claims immediately after having regard to criminal
report.

3. Responsible in the sense of the UrhG and these terms and conditions, in addition to the owner of the
company or the industry for non-existing persons identity of the creator of the website using this book is
offered for download or in any other manner.

4. Information about the legality of a planned use of the book given by the author. The contact data the
author can bee seen in the imprint on the web page.

VI. Liability

The author assumes no liability whatsoever, regardless of the legal grounds, arising out of the use and/
or the use of the book or in any other way in connection with the acquisition, exploitation and use of the
book could be deducible, except in cases of intent or gross negligence.

The brand names used in this manual are registered trademarks of their respective owners.
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